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Troubleshooting
This section contains information about general troubleshooting issues and Windows 2000 Troubleshooters.

Troubleshooter overview
Troubleshooter Overview
The Windows 2000 troubleshooters help you diagnose and solve technical problems that are occurring with your computer. When you start a troubleshooter, you must answer a series of questions about the problem you are having. These answers will help Windows 2000 find a solution to your problem. 
There are several different troubleshooters, each one designed to solve a different type of problem. 
Using the Troubleshooters
To get the best results from the Windows 2000 troubleshooters, follow these guidelines: 
 1.
Resize the Help window and move it to the right half of your screen so you can use the left half of your screen to follow the instructions. 
 2.
Hide the navigation pane of the Help window by clicking Hide on the Help toolbar. 
 3.
Follow the troubleshooter steps exactly. If you do not, you may miss critical information and limit the effectiveness of the troubleshooter. 
 4.
Some troubleshooter steps require you to restart your computer or close the troubleshooter window. If this is required, and you only have access to one computer, you should do the following: 

Print the troubleshooter step by clicking Print on the Help toolbar, and then clicking OK. Double-click all headings within the step you are printing to verify that all the procedures are open. 

Write down, or remember, how you answered each question in the troubleshooter so you can return to the same location in the troubleshooter after your computer restarts or after you reopen the troubleshooter window. 
Troubleshooters
The following troubleshooters are available in Windows 2000 Server. 
Troubleshooter
Identifies and resolves problems related to
Client Service for Netware
Client Service for Netware, including accessing Netware servers and Novell Directory Services (NDS) objects, printing to Netware printers, using Netware login scripts, and logging onto an NDS tree.
DHCP
Configuring the Dynamic Host Configuration Protocol (DHCP) service on a server, including related error messages and events that appear in the event log.
Display
Video cards and display adapters, including your computer screen, outdated or incompatible video drivers, and incorrect settings for your video hardware.
Group Policy and Active Directory
Group Policy and configuring Active Directory on a server, including related error messages and events that appear in the event log.
Domain Name System
Configuring Domain Name System (DNS) on a server, including related error messages and events that appear in the event log.
Hardware
Cameras, CD-ROM drives, game controllers, hard drives, keyboards, mouse devices, network adapters, and scanners. If you are having problems with a sound card, a modem, or a display or video adapter, see the individual troubleshooters for those devices.
Internet connections 
Connecting and logging on to your Internet Service Provider (ISP).
Modem
Modem connections, setup, configuration, and detection.
MS-DOS programs
Running MS-DOS programs on Windows 2000.
Multimedia and games
Installing and configuring Direct X drivers and games.
Networking (TCP/IP)
Internet and intranet connections (client side only) that use Transmission Control Protocol/Internet Protocol (TCP/IP).
Print 
Network or local printers and plotters, including outdated or corrupted printer drivers, network and local printer connections, and printer configuration. 
Routing and Remote Access
Dial-up networking connections that use a telephone to connect your computer to another computer.
Remote Installation Services
Installing Windows 2000 using Remote Installation Services.
Sound
Sound cards and speakers.
Startup and shutdown 
Choosing an operating system at startup, corrupted Ntldr and Ntdetect files, and startup errors related to floppy drives, SCSI host adapters, video, and hard drives. 
Stop errors
System startup errors, including Stop errors that occur on Windows 2000 Server.
System setup
Installing and setting up Windows 2000.
Network Administration 
Configuring and managing the Windows 2000 Server.
Windows 3.x programs
Running 16-bit Windows programs on Windows 2000. If you are having problems running an MS-DOS program, see the MS-DOS troubleshooter.
WINS 
Configuring Windows Internet Name Service (WINS) on a server, including related error messages and events that appear in the event log.
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Directory of Windows 2000 Applications
The Directory of Windows 2000 Applications provides the most recent information about compatible and certified applications for the Windows 2000 Server operating system. You can search for information about applications designed for earlier versions of Windows and new applications designed for Windows 2000 Server. For more information, see the Directory of Windows 2000 Applications at the Microsoft Web site (http://www.microsoft.com/).
Windows 2000 Resource Kits
The Microsoft Windows 2000 Resource Kits are the official source of technical background information about the Windows 2000 operating system. They provide detailed support for system and network administrators, Webmasters, and advanced users who configure, administer, optimize, and troubleshoot Windows 2000, and networks and Web sites based on it. Because these materials come directly from the Microsoft product development teams, they provide the most complete technical information and tools available for deploying and supporting the operating system.
The Windows 2000 Resource Kits include the printed and online Windows 2000 Resource Kit books; and documentation for the registry, performance counters, error and event messages, and Group Policy settings. They come with a companion CD whose contents can be installed on a computer running Windows 2000. The Windows 2000 Resource Kits also provide documentation for the more than 200 tools included on the Resource Kit companion CD.
The Windows 2000 Professional Resource Kit contains:

The Windows 2000 Professional Resource Kit printed book, containing information about core technologies for Windows 2000 Professional. 

The Resource Kit companion CD, which includes: 

The Microsoft Windows 2000 Professional Resource Kit book in online format. 

A subset of the Resource Kit tools. 

Documentation for the tools, the registry, performance counters, error and event messages, and Group Policy settings. 
The Windows 2000 Server Resource Kit contains:

The Windows 2000 Server Resource Kit printed books, seven volumes containing information about technologies included in Windows 2000 Server: 

Microsoft Windows 2000 Server Deployment Planning Guide 

Microsoft Windows 2000 Server Operations Guide 

Microsoft Windows 2000 Server Distributed Systems Guide 

Microsoft Windows 2000 Server TCP/IP Core Networking Guide 

Microsoft Windows 2000 Server Internetworking Guide 

Microsoft Windows 2000 Server Internet Explorer Resource Guide 

Microsoft Windows 2000 Server Internet Information Services Resource Guide 

The Resource Kit companion CD, which includes:

All Resource Kit books in online format, including the Microsoft Windows 2000 Professional Resource Kit. 

The complete set of over 200 Resource Kit tools. 

Documentation for the tools, the registry, performance counters, error and event messages, and Group Policy settings. 
For more information about the Windows 2000 Resource Kits, see the Windows 2000 Web site (http://windows.microsoft.com/).
Windows 2000 Support Tools
The Windows 2000 CD set contains a subset of the Windows 2000 Resource Kits, including:

The Microsoft Windows 2000 Server Deployment Planning Guide in online format. 

Approximately 50 of the Resource Kit tools. 
To view the following online documentation, you must first have installed the Windows 2000 Support Tools from the Windows 2000 CD.
Open Deployment Planning Guide.
Open Windows 2000 Support Tools Help.
Notes

To open the Deployment Planning Guide after it is installed, click Start, point to Programs, point to Windows 2000 Support Tools, and then click Deployment Planning Guide. 

To open Windows 2000 Support Tools Help after it is installed, click Start, point to Programs, point to Windows 2000 Support Tools, and then click Tools Help. 
Hardware Compatibility List
The Windows 2000 Hardware Compatibility List contains a list of computers, system components, and peripherals that are compatible with Windows 2000 Server. To view this list, see the Microsoft Web site. (http://www.microsoft.com/)
Updated Technical Information
The Microsoft Personal Online Support Web site contains an extensive collection of articles, troubleshooting wizards, items you can download, and other useful product information. The articles are in-depth papers written to help you understand more about the features included in Windows 2000.
Microsoft Personal Online Support provides two search options: Basic Search and Advanced Search. To access either search option, first click Search Personal.
In addition, Microsoft Personal Online Support contains other information you may find useful, such as frequently asked questions (FAQs), troubleshooting information, and information from newsgroups.
For more information, or to begin your search, see the Microsoft Web site (http://www.microsoft.com/).
Microsoft Product Support Services
If you have a question about Microsoft Windows 2000, first look in the printed manual or consult Help. You can also find late-breaking updates and technical information in the readme files that came with your Windows 2000 CD.
If you still have a question, Microsoft offers technical support and services ranging from self-help tools to direct assistance with a Microsoft support technician.
Microsoft's support services are subject to Microsoft's current prices, terms, and conditions, which are subject to change without notice.
Microsoft Product Support Services in the U.S. and Canada (http://www.microsoft.com/support)
Microsoft Product Support Services worldwide (http://www.microsoft.com/professional/ww.asp)
Downloads and the Latest Help Files
You can download drivers, patches, the latest Help files, and products from the Windows Update Web site to keep your computer up to date. You must be logged on with administrator privledges to update system files on Windows 2000, including Help files. For more information, see Windows Update at the Microsoft Web site (http://windowsupdate.microsoft.com/).
You can view the latest documentation for Windows 2000 Server on the Windows Home Pages Web site. For more information, see the Microsoft Web site (http://www.microsoft.com/). 
TechNet
TechNet is a service that contains resources for information technology (IT) professionals. This includes access to white papers and articles written by support professionals at Microsoft, career and industry information, discussion groups, technical feedback, and software. For more information about TechNet, see the Microsoft Web site (http://www.microsoft.com/).
Accessibility
Windows 2000 Server contains features to help people with disabilities use the product. In addition, Microsoft offers other products and services for people with disabilities. For more information, and information about products and services offered by other organizations, see Accessiblity for people with disabilities.
Training and Certification
The Training and Certification Web site provides information about Microsoft certification, training, and technical careers. For more information, see Training and Certification at the Microsoft Web site (http://www.microsoft.com/).
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A (address) resource record
AAL (ATM adaptation layer)
ABR (area border router)
ABR (available bit rate)
access control
access control entry (ACE)
access number
access permission
access privileges
account lockout
ACE (access control entry)
ACK (acknowledgment)
acknowledgment message
ACPI (Advanced Configuration and Power Interface)
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active content
Active Directory
Active Directory data model
Active Directory Service Interfaces
Active Directory Users and Computers
active partition
active volume
ActiveX
ActiveX control
adapter card
address classes
address pool
Address Resolution Protocol (ARP)
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administration queue
administrative alerts
administrator
Advanced Configuration and Power Interface (ACPI)
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agent
Alerter service
allocation unit size
Alpha computer
American Standard Code for Information Interchange (ASCII)
APIPA (Automatic Private IP Addressing)
AppleShare
AppleTalk
AppleTalk Filing Protocol
AppleTalk network integration (formerly Services for Macintosh)
AppleTalk Phase 2
AppleTalk Protocol
AppleTalk Transport
application
application assignment
area border router (ABR)
ARP (Address Resolution Protocol)
AS (autonomous system)
ASBR (autonomous system boundary router)
ASCII (American Standard Code for Information Interchange)
Assistive Technology Program
asymmetric encryption
asynchronous communication
ATM (asynchronous transfer mode)
ATM adaptation layer (AAL)
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audit logging
audit policy
auditing
authentication
authoritative
authoritative restore
authorization
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Automatic Private IP Addressing (APIPA)
autonomous system (AS)
autonomous system boundary router (ASBR)
availability
available bit rate (ABR)
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B-ISDN (broadband integrated services digital network)
backbone router
background program
backup domain controller (BDC)
backup media pool
backup operator 
backup set 
backup set catalog 
backup types
bandwidth
Bandwidth Allocation Protocol (BAP)
BAP (Bandwidth Allocation Protocol)
base priority
basic disk
basic input/output system (BIOS)
basic storage
basic volume
batch program
baud rate
BDC (backup domain controller)
Berkeley Internet Name Domain (BIND)
BGP (Border Gateway Protocol)
binary
binary digit (bit)
BIND (Berkeley Internet Name Domain)
BIND boot file
bindery
binding
BINL(Boot Information Negotiation Layer) Service
BIOS (basic input/output system)
bit (binary digit)
bits per second (bps)
boot
boot disk
boot files
Boot Information Negotiation Layer (BINL) Service
Boot Logging
boot partition
boot volume 
BOOTP (bootstrap protocol)
BOOTP extensions
BOOTP Relay Agent
bootstrap protocol (BOOTP)
Border Gateway Protocol (BGP)
bps (bits per second)
broadband integrated services digital network (B-ISDN)
broadcast and unknown server (BUS)
broadcast message
broadcast network
buffer
built-in groups
bus
BUS (broadcast and unknown server)
bytes received
bytes transmitted
C
CA (certification authority)
cache
cache file
caching
caching resolver
Callback Control Protocol (CBCP)
callback number
callback security
called subscriber ID (CSID) string
canonical (CNAME) resource record
canonical name
CAPI (CryptoAPI)
capture 
capture password
capture trigger
cartridge font
catalog
CBCP (Callback Control Protocol)
CBR (constant bit rate)
CCITT (Consultative Committee on Telephony and Telegraphy)
CCP (Compression Control Protocol)
CDFS (Compact Disc File System)
CDP (CRL Distribution Point)
certificate
certificate revocation list (CRL)
Certificate Services
certificate store
certificate template
certificate trust list (CTL)
certification authority (CA)
certification hierarchy
certification path
Challenge Handshake Authentication Protocol (CHAP)
channel
CHAP (Challenge Handshake Authentication Protocol)
character mode
child domain
child object 
Chooser
Chooser Pack
circuit switching
Class A IP address
Class B IP address
Class C IP address
classical IP over ATM (CLIP)
clear
clear-text passwords
client
client application
client request
Client Service for NetWare
CLIP (classical IP over ATM)
ClipBook Server 
cluster
cluster adapter
Cluster Administrator
Cluster Administrator extension
Cluster API
cluster log
Cluster service
cluster size
cluster storage
cluster-aware application
cluster-unaware application
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CNAME (canonical) resource record
CMYK color space
code page
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color gamut
color management
color profile
color space
COM Internet Services Proxy
Command Prompt window
common groups
communication port
communication settings
community name
Compact Disc File System (CDFS)
Compression Control Protocol (CCP)
computer account
Computer Browser service
computer quota
computer-telephony integration (CTI)
conflict detection
connect
connected user
connected, authenticating user
connected, user authenticated
connection-oriented
connectionless
connector application
connector queue
console tree
constant bit rate (CBR)
Consultative Committee on Telephony and Telegraphy (CCITT)
container object 
convergence
copy backup
count to infinity
CPU Time 
CPU Usage 
CRC errors
CRL (certificate revocation list)
CRL Distribution Point (CDP)
cross-reference object
CryptoAPI (CAPI)
cryptographic service provider (CSP)
cryptography
CSID (Called Subscriber ID) string
CSP (cryptographic service provider)
CTI (computer-telephony integration)
CTL (certificate trust list)
custom file type 
D
D-channel
DACL (discretionary access control list)
daily backup
Data Communications Equipment (DCE)
data fork
Data Link Control (DLC)
Data Terminal Equipment (DTE)
data-overrun error
DCE (Data Communications Equipment)
DDE (dynamic data exchange)
dead-letter queue
debugger
dedicated adapter
default button
default host
default network
default printer
default tree and context
default user
default zone
defragmentation
delegation
demand-dial connection
demand-dial routing
dependency
dependency tree
dependent client
descendent key
desired zone
desktop
desktop pattern
destination document
details pane
device
device conflict 
device driver
device fonts
Device Manager
Dfs link
Dfs path
Dfs replication
Dfs root
Dfs topology
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DHCP decline message (DHCPDECLINE)
DHCP information message (DHCPINFORM)
DHCP negative acknowledgment message (DHCPNAK)
DHCP offer message (DHCPOFFER)
DHCP option
DHCP relay agent
DHCP release message (DHCPRELEASE)
DHCP request message (DHCPREQUEST)
DHCP server
DHCP Service resource
DHCPACKDHCP (acknowledgment message)
DHCPDECLINE (DHCP decline message)
DHCPINFORM (DHCP information message)
DHCPNAK (DHCP negative acknowledgment message)
DHCPOFFER (DHCP offer message)
DHCPRELEASE (DHCP release message)
DHCPREQUEST (DHCP request message)
dial location
dial-up connection
dial-up line
differential backup
digital signature
Digital Signature Standard (DSS)
digital subscriber line (DSL)
digital video disc (DVD)
direct cable connection
direct hosting
direct memory access (DMA)
directory
directory database
directory partition
directory replication
Directory Service
disable 
discovery
discretionary access control list (DACL)
disk 
disk configuration information
disk mirroring
dismount
display adapter
display password
distinguished name
Distributed Transaction Coordinator resource
distribution group
DLC (Data Link Control)
DLL (dynamic-link library)
DMA (direct memory access)
DNS
DNS dynamic update protocol
DNS name servers
docking station
document
domain
domain controller
domain Dfs
domain local group
domain model
domain name
domain namespace
domain naming master
domain of origin
domain suffix
domain tree
dots per inch (DPI)
downcasing
downloadable fonts
DPI (dots per inch)
drag
drain
drainstop
drive
drive letter
drop folder
DSL (digital subscriber line)
DSS (Digital Signature Standard)
DTE (Data Terminal Equipment)
dual boot
duplex
DVD decoder
DVD (digital video disc)
DVD drive
DWORD
dynamic data exchange (DDE)
dynamic disk 
DHCP
dynamic routing
dynamic storage
dynamic volume 
dynamic-link library (DLL)
E
EAP (Extensible Authentication Protocol)
EFS (encrypting file system)
ELAN (emulated local area network)
embedded object 
emergency repair disk (ERD)
emulated local area network (ELAN)
enable 
encapsulated PostScript (EPS) file
encapsulation
encrypted password
encrypting file system (EFS)
encryption
enhanced small device interface (ESDI)
environment variable
EPS (encapsulated PostScript) file
ERD (emergency repair disk)
error detection
ESDI (enhanced small device interface)
event
Event Log service
event logging
everyone category
exclusion range
exclusive OR (XOR)
expanded memory
expansion slot
expire interval
explicit permissions
express message
extended memory
extended partition
Extensible Authentication Protocol (EAP)
extension-type association
external network number
F
failback
failback policy
failed
failover
failover policy
failover time
FAT (file allocation table)
FAT32
fault tolerance
Fax Service 
FCB (file control block)
Federal Information Processing Standard 140-1 (FIPS 140-1)
FEP (front-end processor)
file allocation table (FAT)
File and Print Services for NetWare
file control block (FCB)
file creator
file fork
file replication service
File Services for Macintosh
File Share resource
file system
File Transfer Protocol (FTP)
file type
filter
filtering mode
FIPS 140-1 (Federal Information Processing Standard 140-1)
firewall
firmware
font
font cartridge
foreground program
foreign computer
forest
form
FORTEZZA
forward lookup
forwarder
FQDN (fully qualified domain name) 
fragmentation
frame
frame type
free media pool
free space
front-end processor (FEP)
FTP (File Transfer Protocol)
full-duplex
full name
full zone transfer (AXFR)
fully qualified domain name (FQDN)
G
gateway
gateway account
Gateway Service for NetWare
GDI objects
Generic Application resource
Generic Service resource
global account
global catalog
global group
glue chasing
glue records
graphics mode
gratuitous ARP
group
group account
group memberships
group name
Group Policy
Group Policy object
guest
guest account
H
H.323
half-duplex
handle count
handshaking
Hardware Compatibility List (HCL)
hardware compression
hardware configuration 
hardware decoder
hardware profile
hardware type 
hash
hash algorithm
Hash-based Message Authentication Code (HMAC)
HCL (Hardware Compatibility List)
header error control (HEC)
heartbeat
HEC (header error control)
heterogeneous environment
hexadecimal 
high availability
histogram
hive
HMAC (Hash-based Message Authentication Code)
home directory
host
host ID
host name
host priority
Hosts file
HTML (Hypertext Markup Language)
hub
hubbed mode
hue
Hypertext Markup Language (HTML)
I
I/O (input/output) port 
IAS (Internet Authentication Service)
ICMP (Internet Control Message Protocol)
IDE (integrated device electronics)
IEEE 1394
IETF (Internet Engineering Task Force)
IGMP (Internet Group Management Protocol)
IIS (Internet Information Services)
IIS Server Instance resource
ILMI (integrated local management interface)
Image Name
IME (Input Method Editor)
impersonation
import media pool
in-addr.arpa domain
incremental backup
incremental zone transfer (IXFR)
independent client
Indexing Service
.inf
infrared (IR)
Infrared Data Association (IrDA)
infrared device
infrared file transfer
infrared network connection
infrared port
infrastructure master
inheritance
inherited permissions
Initial master
initialize
input locale
Input Method Editor (IME)
input/output (I/O) port
install
integrated device electronics (IDE)
integrated local management interface (ILMI)
Integrated Services Digital Network (ISDN)
interactive dialog box
interactive logon
interconnect
intermediary device
internal network number
internal router
international prefix
International Telecommunication Union - Telecommunication (Standardization Sector) (ITU-T)
internet
Internet address
Internet Authentication Service (IAS)
Internet Control Message Protocol (ICMP)
Internet Engineering Task Force (IETF)
Internet Group Management Protocol (IGMP)
Internet group name
Internet Information Services (IIS)
Internet Protocol (IP)
Internet Protocol multicasting
Internet service provider (ISP)
Internetwork Packet Exchange (IPX)
interrupt
interrupt request (IRQ)
interrupt request (IRQ) lines
intersite messaging service (ISM)
IP (Internet Protocol)
IP address
IP Address resource
IP multicasting
IPX (Internetwork Packet Exchange)
IPX/SPX
IR (infrared)
IrDA (Infrared Data Association)
IRQ (interrupt request) lines
ISDN (Integrated Services Digital Network)
ISM (intersite messaging service)
ISP (Internet service provider)
iteration
iterative query
ITU-T (International Telecommunication Union - Telecommunication [Standardization Sector])
IXFR (incremental zone transfer)
J
journal queue
journal quota
junction point
K
KDC (Key Distribution Center)
Kerberos V5
key
Key Distribution Center (KDC)
keyboard layout
L
L2TP (Layer 2 Tunneling Protocol)
label
LAN (local area network)
LAN emulation (LANE)
LAN emulation client (LEC)
LAN emulation server (LES)
LANE (LAN emulation)
LANE emulation configuration server (LECS)
last known good configuration
latency
Layer 2 Tunneling Protocol (L2TP)
LDAP (Lightweight Directory Access Protocol)
LDAP Data Interchange Format (LDIF)
LDIF (LDAP Data Interchange Format)
lease
LEC (LAN emulation client)
LECS (LANE emulation configuration server)
LES (LAN emulation server)
library
Lightweight Directory Access Protocol (LDAP)
Line Printer Daemon (LPD)
Line Printer Remote (LPR) 
link state database
linked object 
LIS (logical IP subnet)
LMHOSTS file
load balancing
local account
local area network (LAN)
local computer 
local group
local printer
local service
local storage
local user profile
LocalTalk
location
log file
logical drive
logical IP subnet (LIS)
logical printer
logon rights
logon script
logon script path
logon workstations
long distance operator
long name
loose name checking
LPD (Line Printer Daemon)
LPR (Line Printer Remote) 
luminosity
M
MAC (Message Authentication Code)
MAC address
machine-centric
Macintosh-accessible volume
Macintosh-style permissions
MADCAP (Multicast Address Dynamic Client Allocation Protocol)
Make Changes
managed volume
Management and Monitoring Tools
Management Information Base (MIB)
management system
mandatory user profile
MAPI (Messaging API)
MARS (multicast address resolution service)
master boot record (MBR)
master domain
Master File Table (MFT)
master server
maximize
maximum password age
MBR (master boot record)
MCS (multicast server)
MD2
MD4
MD5 (Message Digest Five)
MDHCP (multicast DHCP)
media
media access control address
media pool
member server
memory address
Memory Usage 
Memory Usage Delta 
message
Message Authentication Code (MAC)
message digest
Message Digest Five (MD5)
Message Queuing
Message Queuing resource
Message Queuing server
Messaging API (MAPI)
Messenger service
metric
MFT (Master File Table)
MIB (Management Information Base)
Microcom Networking Protocol Five (MNP5)
Microcom Networking Protocol Four (MNP4)
Microsoft Distributed Transaction Coordinator (MS DTC)
Microsoft Management Console (MMC)
Microsoft Point-to-Point Encryption (MPPE)
MIDI (Musical Instrument Digital Interface)
MIDI setup
minimize
minimum password length
minimum TTL
mirror
mirror set
mirrored volume 
mixed mode
MMC (Microsoft Management Console)
MNP4 (Microcom Networking Protocol Four)
MNP5 (Microcom Networking Protocol Five)
modem
modem compression
modulation standards
mount
mounted drive
MPPE (Microsoft Point-to-Point Encryption)
MPR (MultiProtocol Routing)
MS DTC (Microsoft Distributed Transaction Coordinator)
MS-DOS
MS-CHAP (Challenge Handshake Authentication Protocol)
MS-DOS-based program
MSMQ
multibyte
Multicast Address Dynamic Client Allocation Protocol (MADCAP)
multicast address resolution service (MARS)
multicast datagram
multicast DHCP (MDHCP)
multicast media access control address
multicast scope
multicast server (MCS)
multicasting
multihomed computer
multilink dialing
multimaster replication
multimedia streaming
multiple boot
MultiProtocol Routing (MPR)
Musical Instrument Digital Interface (MIDI)
My Documents
N
name
name mapping
name resolution
name server (NS) resource record
named pipe
namespace 
naming context
naming service
NAS (network access server)
native mode
NCP (NetWare Core Protocol)
NDIS (network driver interface specification)
NDS (Novell Directory Services)
negative caching
NetBEUI (NetBIOS Enhanced User Interface)
NetBIOS (network basic input/output system)
NetBIOS Enhanced User Interface (NetBEUI)
netmask ordering
NetWare Core Protocol (NCP)
network access server (NAS)
network adapter
network administrator
network basic input/output system (NetBIOS)
network bridge
network card driver
Network DDE service 
network driver
network driver interface specification (NDIS)
network file system (NFS)
network gateway
network ID
Network Information Service (NIS)
network media
Network Name resource
Network News Transfer Protocol (NNTP)
network number
network partition
network/bit-masked identifier
network-to-network interface (NNI)
NFS (network file system)
NIS (Network Information Service)
NNI (network-to-network interface)
NNTP (Network News Transfer Protocol)
node
nonauthoritative restore
noncontainer object 
nonhubbed mode
nonpaged memory
nonpaged pool 
nontransitive trust
normal backup
notify list
Novell Directory Services (NDS)
NS (name server) resource record
nslookup
NTFS file system
NTGATEWAY
null modem cable
NWLink
O
object
object identifier
offline
OLE
on-disk catalog 
on-media catalog 
one-way trust
online
Open Shortest Path First (OSPF)
Open Systems Interconnection model (OSI)
OpenType fonts
operations master
operator
organizational unit
orphan
orphan file
OS/2
OSChooser
OSI (Open Systems Interconnection model)
OSPF (Open Shortest Path First)
owner
owner category
P
p-node
package
packet
packet assembler/disassembler (PAD)
packet header
packet switching
PAD (packet assembler/disassembler)
page fault 
Page Faults Delta 
paged pool 
paging file 
PAP (Password Authentication Protocol)
paper source
parent domain
parent object
parenting
parity
parity bit
partition
partition boot sector
password
Password Authentication Protocol (PAP)
paused
PBX (Private Branch Exchange)
PC Card
PCL (Printer Control Language)
PDC (primary domain controller)
PDC emulator master
Peak Memory Usage
pel
pending
Per Seat Licensing
Per Server Licensing
performance alert
performance counter
performance object
performance object instance
permanent virtual circuit (PVC)
permission
Physical Disk resource
PID (process identifier) 
PIF (program information file)
ping
pixel 
PJL (Printer Job Language)
PKCS (Public Key Cryptography Standards)
PKCS #7
PKCS #10
PKCS #12
PKI (public key infrastructure)
plotter font
Plug and Play 
PNNI (private or public network-to-network interface)
point of presence (POP)
point of termination station (POTS)
Point-to-Point Protocol (PPP)
Point-to-Point Tunneling Protocol (PPTP)
pointer (PTR) resource record
poison reverse
policy
polling intervals
POP (point of presence)
port 
port ID
port rule
POSIX
possible owners
PostScript
PostScript fonts
PostScript printer
POTS (point of termination station)
power conditioning
PPP (Point-to-Point Protocol)
PPTP (Point-to-Point Tunneling Protocol)
predefined key
preferred owner
preferred server
preset-to callback
Primary disk
primary domain controller (PDC)
primary group
primary master
primary partition
print job
print processor
print server
Print Server for Macintosh
print spooler
Print Spooler resource
printer
Printer Control Language (PCL)
printer driver
printer fonts
Printer Job Language (PJL)
printer permissions
Printer window
Printers
printing pool
Private Branch Exchange (PBX)
private key
private network
private or public network-to-network interface (PNNI)
private queue
private volume
privileges
process identifier (PID) 
program
program information file (PIF)
property
property cache
property value
protocol
protocol parser
PSTN (Public Switched Telephone Network)
PTR (pointer) resource record
public key
public key cryptography 
Public Key Cryptography Standards (PKCS)
public key encryption
public key infrastructure (PKI)
public network
public queue
Public Switched Telephone Network (PSTN)
pull partner
pulse dialing
push partner
PVC (permanent virtual circuit)
Q
QoS (Quality of Service)
QoS Admission Control Service
Quality of Service (QoS)
query
queue
queue quota
queue type ID
quiet answer
quorum log
quorum resource
quota limit
R
RADIUS (Remote Authentication Dial-In User Service)
RAID (Redundant Array of Independent Disks)
RAID-5 volume 
RAM (random-access memory)
random-access memory (RAM)
raster fonts
read-only memory (ROM)
Real-Time Transport Protocol (RTP)
realm
realm name
rebinding state
reconciliation
recoverable message
recovery agent
Recovery Console
recursion
recursive query
Recycle Bin 
reduced instruction set computing (RISC)
Redundant Array of Independent Disks (RAID)
referral
referral server
refresh
refresh interval
refresh rate
region
registered file type 
registry
registry boot
registry size limit (RSL)
relative distinguished name
relative ID
relative ID master
relative name
remote access
remote access server
remote administration
Remote Authentication Dial-In User Service (RADIUS)
remote computer 
Remote Installation Services
remote procedure call (RPC)
remote storage
Remote Storage
removable media
Removable Storage
rendering intent
rendezvous
replica
replica set
replication
replication policy
replication topology
report message
report queue
Request for Comments (RFC)
required callback
reservation
resolver
resource
resource allocation
Resource DLL
resource domain
resource fork
Resource Monitor
resource record (RR)
resource record set (RRset)
Resource Reservation Protocol (RSVP)
resource types
response
response message
response queue
retry interval
reverse lookup
RFC (Request for Comments)
RGB color space
RIPX (Routing Information Protocol over IPX)
RISC (reduced instruction set computing)
roaming user profile
ROM (read-only memory)
root
root authority
root certificate
root hints
root servers
round robin
Routemon utility
router
routing
Routing Information Protocol over IPX (RIPX)
routing link
routing-link cost
routing protocol
routing services
RPC (remote procedure call)
RR (resource record)
RRset (resource record set)
RS-232-C standard
RSA
RSL (registry size limit)
RSVP (Resource Reservation Protocol)
RTP (Real-Time Transport Protocol)
S
S/MIME (Secure Multipurpose Internet Mail Extensions)
SACL (system access control list )
safe mode
safe mode with command prompt
safe mode with networking
SAM (security account manager)
SAM account name
saturation
SBM (subnet bandwidth management)
scalability
scavenging
schema
schema master
scope
scope of influence
screen fonts
screen resolution
screen saver
SCSI (small computer system interface)
SDP (Standard Description Protocol)
second-level domains
secondary master
secret key encryption
sector
Secure Hash Algorithm (SHA-1)
Secure Multipurpose Internet Mail Extensions (S/MIME)
Secure Sockets Layer (SSL)
security
security account manager (SAM)
security descriptor
security group
security host
security ID (SID)
security identifier
security log
security principal
security principal name
See Files
See Folders
seed router
Serial Line Internet Protocol (SLIP)
serial port
server
server application
server cluster
server zone
service
Service Profile Identifier (SPID)
service (SRV) resource record
service ticket
service-centric
Services for Macintosh (now called AppleTalk network integration)
session
session concentration
set-by-caller callback
SHA-1 (Secure Hash Algorithm)
share
shared folder
shared folder permissions
shared network directory
shared printer
shared resource
short name
shortcut 
SID (security ID)
signaling protocol
signature PKI
Simple Mail Transfer Protocol (SMTP)
Simple Network Management Protocol (SNMP)
Simple TCP/IP Services
simple volume
Single Instance Store (SIS)
single sign-on
SIS (Single Instance Store)
site
Site Server ILS Service
SLIP (Serial Line Internet Protocol)
small computer system interface (SCSI)
smart card
smart card reader
SMTP (Simple Mail Transfer Protocol)
snap-in
SNMP (Simple Network Management Protocol)
SOA (start-of-authority) resource record
software decoder
source document
source journaling
spanned volume 
sparse file
special access permissions
SPID (Service Profile Identifier)
split horizon
splitting
spooler
spooling
SRV (service) resource record
SSL (Secure Sockets Layer)
stand-alone server
Standard Description Protocol (SDP)
start-of-authority (SOA) resource record
startup environment
static dialog box
static load balancing
static routes
status area
status bar
STOP error 
storage-class resource
strict RFC checking
string
stripe set
stripe set with parity
striped volume 
subdomain
subkey
subnet bandwidth management (SBM)
subtree
superscope
SVC (switched virtual circuit)
swap file
switch type
switched circuit
switched virtual circuit (SVC)
switching hub
symmetric encryption
system access control list (SACL)
system default profile
system disk
system files
System menu
system partition
system policy
system queue
System State
system variables
system volume 
systemroot
Systems Management Server
SYSVOL
T
T.120
tag
TAPI (Telephony API)
target journaling
taskbar
taskbar button
TCP/IP (Transmission Control Protocol/Internet Protocol)
Telephony API (TAPI)
telephony switch
Terminal Services
Terminal Services Licensing
terminate-and-stay-resident (TSR) program
test queue
text box
TFTP (Trivial File Transfer Protocol)
TGS (ticket-granting service)
TGT (ticket-granting ticket)
Thread Count 
thumbnail 
ticket
ticket-granting service (TGS)
ticket-granting ticket (TGT)
time slice
time stamp
time-out error
Time-To-Live (TTL)
title bar
TLS (Transport Layer Security)
top-level domains
topological database
topology
touch-tone dialing
trace log
transaction
transaction dead-letter queue
transactional message
transitive trust
Transmission Control Protocol/Internet Protocol (TCP/IP)
transmitting station ID (TSID) string
Transport Layer Security (TLS)
trap
tree view
triggered update
Trivial File Transfer Protocol (TFTP)
Trojan horse
TrueType fonts
trust relationship
TSID (transmitting station ID) string
TSR (terminate-and-stay-resident) program
TTL (Time-To-Live)
tunnel
tunnel server
two-way trust
Type 1 fonts
U
UAM (user authentication module)
UBR (unspecified bit rate)
UCS (Unicode Character System)
UDP (User Datagram Protocol)
unallocated space
UNC (Universal Naming Convention) name
UNI (user network interface)
unicast
Unicode
Unicode Character System (UCS)
Unicode Transmission Format 8 (UTF-8)
uninstall
uninterruptible power supply (UPS)
universal group
Universal Naming Convention (UNC) name
universal serial bus (USB)
unspecified bit rate (UBR)
upcasing
upgrade
UPS (uninterruptible power supply)
UPS service
USB (universal serial bus)
user account
user authentication module (UAM)
user class
User Datagram Protocol (UDP)
user name
user network interface (UNI)
USER object
user password
user principal name
user principal name suffix
user profile
user rights
user rights policy
Users
UTF-8 (Unicode Transmission Format 8)
V
V.34
V.90
validation
value entry
variable
variable bit rate (VBR)
VBR (variable bit rate)
VCI (virtual channel identifier)
VDM (virtual DOS machine)
vector
vector fonts
vendor class
video codec
virtual channel identifier (VCI)
virtual container
virtual DOS machine (VDM)
virtual IP address
virtual link
virtual local area network (VLAN)
virtual memory
Virtual Memory Size
virtual network
virtual path identifier (VPI)
virtual printer memory
virtual private network (VPN)
virtual server
virus
VLAN (virtual local area network)
VoIP (Voice over Internet Protocol)
volume
volume password
volume set
voluntary tunnel
VPI (virtual path identifier)
VPN (virtual private network)
W
Waiting for Call
wallpaper
WAN (wide area network)
warning level
Web folder
Web server
well-connected
well-known services
wide area network (WAN)
wildcard character
wildcarding
window menu
Windows 2000 Server File and Print Servers for Macintosh
Windows 2000 Task Manager
Windows Internet Name Service (WINS)
Windows Management Instrumentation (WMI)
Windows Media Services
WINS (Windows Internet Name Service)
WINS proxy
WINS resource
Winsock
wireless communication
WMI (Windows Management Instrumentation)
workgroup
X
X.500
X.509v3 certificate
XOR (exclusive OR)
Y
No Glossary entries
Z
zone
zone list
zone transfer
For additional help on MS-DOS commands, at the command prompt, type the following: command_name /?
Windows 2000 Command
For additional help on MS-DOS commands, at the command prompt, type the following: 
command_name /?
A
Append
Arp 
Assoc 
At 
Atmadm 
Attrib 
B
Batch commands 
Break 
Buffers 
C
Cacls 
Call 
Chcp
Chdir (cd) 
Chkdsk 
Chkntfs 
Cipher 
Cls 
Cluster
Cluster commands overview
Cluster group
Cluster node
Cluster netinterface
Cluster network
Cluster resource
Cluster resourcetype
Cmd 
Codepage 
Color 
Command symbols and filter commands 
Comp 
Compact 
Conditional processing symbols 
Convert 
Copy 
Country 
D
Date 
Debug 
Debug subcommands 
Del (Erase) 
Device 
Devicehigh (dh) 
Devinfo 
Dir 
Diskcomp 
Diskcopy 
Diskperf 
Dos 
Doskey 
Dosonly 
Driveparm 
E
Echo 
Echoconfig 
Edit 
Edlin 
Edlin subcommands 
Endlocal 
Evntcmd 
Exe2bin 
Exit 
Expand 
F
Fastopen 
Fc 
Fcbs 
Files 
Filter commands 
Find 
Findstr 
Finger 
For 
Forcedos 
Format 
Ftp 
Ftp commands 
Ftype 
G
Goto 
Graftabl 
Graphics 
H
Help 
Hostname 
I
If 
Install 
Ipconfig 
Ipxroute 
Irftp 
L
Label 
Lastdrive 
Libpath 
Loadfix 
Loadhigh (lh) 
Lpq 
Lpr 
M
Mem 
Mkdir (md) 
Mode 
More 
Mountvol 
Move 
MS-DOS configuration commands 
MS-DOS subsystem commands 
N
Nbtstat 
Net (command options) 
Net accounts 
Net computer 
Net config 
Net config server 
Net config workstation 
Net continue 
Net file 
Net group 
Net help 
Net helpmsg 
Net localgroup 
Net name 
Net pause 
Net print 
Net send 
Net session 
Net share 
Net start 
Net start Alerter 
Net start Client Service for NetWare 
Net start ClipBook Server 
Net start Computer Browser 
Net start DHCP Client 
Net start Directory Replicator 
Net start Eventlog 
Net start File Server for Macintosh 
Net start FTP Publishing Service 
Net start Gateway Service for NetWare 
Net start Lpdsvc 
Net start Messenger 
Net start Microsoft DHCP Service 
Net start Net Logon 
Net start Network DDE 
Net start NT LM Security Support Provider 
Net start OLE 
Net start Print Server for Macintosh 
Net start Remote Access Connection Manager 
Net start Remote Access ISNSAP Service 
Net start Remote Procedure Call (RPC) Locator 
Net start Remote Procedure Call (RPC) Service 
Net start Schedule 
Net start Server 
Net start Simple TCP/IP Services 
Net start Site Server LDAP Service 
Net start SNMP 
Net start Spooler 
Net start TCP/IP NetBIOS Helper 
Net start UPS 
Net start Windows Internet Name Service 
Net start Workstation 
Net statistics 
Net stop 
Net time 
Net use 
Net user 
Net view 
Netsh
Netstat 
Nlsfunc 
Nslookup 
Nslookup subcommands 
Ntcmdprompt 
O
OS/2 configuration command 
P
Path 
PathPing 
Pause 
Pax 
Pentnt 
Ping 
Popd 
Portuas 
Print 
Prompt 
Protshell 
Pushd 
Q
QBasic 
R
Rcp 
Recover 
Redirection 
Rem 
Rename (ren) 
Replace 
% (Replaceable parameter)
Rexec 
Rmdir (rd) 
Route 
Rsh 
Runas 
S
Set 
Setlocal 
Setver 
Share 
Shell 
Shift 
Sort 
Stacks 
Start 
Subst 
Switches 
T
Tcmsetup
TCP/IP Utilities 
Tftp 
Time 
Title 
Tracert 
Tree 
Type 
V
Ver 
Verify 
Vol 
W
Winnt 
Winnt32 
X
Xcopy 
The Windows 2000 Registry
The Windows 2000 registry is a database that contains system configuration information for the Windows 2000 operating system.

For tips about using the registry and Registry Editor, see Best practices. 

For help with specific tasks, see How to. 

For general background information, see Concepts. 

For problem-solving instructions, see Troubleshooting. 
Best Practices
In Windows 2000, system configuration information is centrally located in the registry. While this simplifies the administration of a computer or network, one incorrect edit to the registry can disable the operating system. The following list provides some best practices for using the registry and Registry Editor safely:

Before making changes to the registry, make a backup copy. 

You can back up the registry by using a program such as Backup. After you make changes to the registry, update your Emergency Repair Disk (ERD). For troubleshooting purposes, keep a list of the changes you make to the registry. For more information, see Backing up, restoring, and recovering the Windows 2000 registry.

Do not replace the Windows 2000 registry with the registry of another version of the Windows or Windows NT operating systems. 

Use tools and programs other than Registry Editor to edit the registry. 

Incorrectly editing the registry may severely damage your system. You should use tools and programs that provide safer methods for editing the registry.

Limit the number of people who have access to the registry. 

For example, because members of the Administrators group have full access to the registry, add only users who need such access to the Administrators group. Also, you can use Group Policy to restrict the use of Registry Editor (both Regedt32.exe and Regedit.exe) for users who do not need access to the registry, or you can simply remove Registry Editor from the computers of these users.

Keep Registry Editor in read-only mode. 

If you use Regedt32.exe, verify that Read Only Mode on the Options menu is checked. When you need to make changes to the registry, click Read Only Mode to turn off read-only mode, and then verify that Confirm on Delete is checked. When you are done making changes and have saved your edits, click Read Only Mode again to turn on read-only mode.

Never leave Registry Editor running unattended.
How To...
This section provides instructions for using the Registry Editor utilities provided in Windows 2000:

Open Registry Editor 

Use Registry Editor 
To open Registry Editor

Click Start, click Run, type regedt32 or regedit (depending on which Registry Editor you want to open), and then click OK.
Caution   Incorrectly editing the registry may severely damage your system. Before making changes to the registry, you should back up any valued data on the computer. Whenever possible, use tools and programs other than Registry Editor to edit the registry. 
Note   To open Registry Editor from a command prompt, click Start, point to Programs, point to Accessories, click Command Prompt, type regedt32 or regedit, and then press ENTER. 
Use Registry Editor

Registry Editor (Regedt32.exe) 

Registry Editor (Regedit.exe) 
Registry Editor (Regedt32.exe)

Use Registry Editor 

Manage registry information 

Add and delete information in the registry 

Edit registry information 

Maintain registry security 

Change the appearance of Registry Editor 

Print registry information 
Registry Editor Overview
Registry Editor is an advanced tool for changing settings in your system registry, which contains information about how your computer runs. Windows 2000 stores its configuration information in a database (the registry) that is organized in a tree format. Although Registry Editor enables you to inspect and modify the registry, normally you do not need to do so, and making incorrect changes can break your system. An advanced user who is prepared to both edit and restore the registry can safely use Registry Editor for such tasks as eliminating duplicate entries or deleting entries for programs that have been uninstalled or deleted.
Folders represent keys in the registry and are shown in the navigation pane. In the topic pane, the value entries in a key are displayed. When you double-click a value entry, it opens an editing dialog box.
You should edit your registry only if it is absolutely necessary. If there is an error in your registry and your computer ceases to function properly, you can restore the registry to its state when you last successfully started your computer.
Registry Editor Keys
The Registry Editor displays windows, each of which represents a predefined key on the local computer. When accessing the registry of a remote computer, only two predefined keys, HKEY_USERS and HKEY_LOCAL_MACHINE, appear.
Window/predefined key
Description
HKEY_CURRENT_USER
Contains the root of the configuration information for the user who is currently logged on. The user's folders, screen colors, and Control Panel settings are stored here. This information is referred to as a user's profile.
HKEY_USERS
Contains the root of all user profiles on the computer. HKEY_CURRENT_USER is a subkey of HKEY_USERS.
HKEY_LOCAL_MACHINE
Contains configuration information particular to the computer (for any user).
HKEY_CLASSES_ROOT
Is a subkey of HKEY_LOCAL_MACHINE\Software. The information stored here ensures that the correct program opens when you open a file by using Windows Explorer.
HKEY_CURRENT_CONFIG
Contains information about the hardware profile used by the local computer at system startup.
Within Registry Editor, you can assign value entries to new keys or you can alter the value entries assigned to a currently selected key. Value entries appear in the registry as strings that consist of three components separated by colons. For example, 
RefCount : REG_DWORD : 0x1
corresponds to the values: 
Entry name
RefCount
Entry type
REG_DWORD
Entry value
0x1
Note   To run Registry Editor, click Start, click Run, and, in the dialog box, type Regedt32.exe. 
Manage Registry Information

Open the registry of the local computer 

Open the registry of a remote computer 

Update registry information 

Close the Registry Editor windows 

Save a registry subtree as a text file 

Restore the registry 
To open the registry of the local computer

On the Registry menu, click Open Local. 
To open the registry of a remote computer
 1.
On the Registry menu, click Select Computer. 
 2.
In Computer, type, or in Select Computer, click, the name of the computer whose registry you want to open, and then click OK. 
Note   You can open two predefined keys (HKEY_USERS and HKEY_LOCAL_MACHINE) of a remote computer registry. 
Updating Registry Information
Registry Editor provides the following ways to update registry information:

Auto Refresh (on the Options menu) automatically updates the registry when any change is made to registry data. 

Refresh All (on the View menu) updates all of the information in all Registry Editor windows. 

Refresh Active (on the View menu) updates only the information in the active Registry Editor window. 
Notes

When Auto Refresh is in effect, a check mark appears next to the command and both Refresh All and Refresh Active on the View menu are unavailable. 

You cannot use Auto Refresh while displaying a remote registry. If you click Auto Refresh while displaying a remote registry, the manual refresh options (Refresh All and Refresh Active) are not available. Although Auto Refresh appears to be working as it would if a local registry window were displayed, the contents of the remote window will not be automatically refreshed. 
To close the Registry Editor windows
 1.
Click a Registry Editor window for the computer whose Registry Editor windows you want to close. 
 2.
On the Registry menu, click Close. 
To save a registry subtree as a text file
 1.
Select the key that you want to save as a text file. 
 2.
On the Registry menu, click Save Subtree As. 
 3.
In Save in, enter the file location. 
 4.
In File name, enter the file name. 
 5.
In Save as type, make sure it says Text Files. 
 6.
Click Save. 
Note   Saving the contents of a registry key as a text file includes all of the key's descendent keys and all of the value entries assigned to its descendent keys. These are saved to the local or network location that you specify. 
To restore the registry
 1.
Because you will have to restart your computer, print this topic first. In this window, click Options and then click Print. 
 2.
On the taskbar, click Start, and then click Shut Down. 
 3.
Click Restart, and then click OK. 
 4.
When you see the message Select an operating system, press F8. 
 5.
Use the arrow keys to highlight Last Known Good Configuration, and then press ENTER. 
 6.
Follow the instructions on the screen. 
Note   Following this procedure will restore your registry to its state when you last successfully started your computer. 
Add and Delete Information in the Registry

Add a key to the registry 

Add a value entry to a registry key 

Save a registry key 

Restore a registry key 

Load a hive into the registry 

Unload a hive from the registry 

Delete a registry key or a value entry 

Confirm a deletion 
To add a key to the registry
 1.
Select the key or subkey under which you want the new key to appear. 
 2.
On the Edit menu, click Add Key. 
 3.
In Key Name, type the name that you want to assign to the new key. 
 4.
In Class, type the class that you want to assign to your key, if necessary. 
Notes

You can use Add Key to add subkeys to a key only if you own the key or have permission to open the key. 

If the HKEY_USERS or HKEY_LOCAL_MACHINE window is active, Add Key is unavailable at the root of the key. To add a registry key to the root of these predefined keys, you must use Load Hive on the Registry menu. 
To add a value entry to a registry key
 1.
Select the key to which you want to add a value entry. 
 2.
On the Edit menu, click Add Value. 
 3.
In Value Name, type the name of the value entry that you want to create. 
 4.
In Data Type, select the data type you want to assign to your value entry: 

To assign a binary value entry to the selected key, select REG_BINARY. 

To assign a DWORD value to the selected key, select REG_DWORD. 

To assign an expandable string to the selected key, select REG_EXPAND_SZ. 

To assign data as a multiple string, select REG_MULTI_SZ. 

To assign a data string to the selected key, select REG_SZ. 
Note   Each entry type has an editor that allows you to change the value of the class or type. The following table illustrates which editor to use to change the value for each entry type. To use the editor that corresponds to these classes, either double-click the value entry or click the corresponding command on the Edit menu. 
Entry type
Editor
REG_BINARY
Binary
REG_SZ
String
REG_DWORD
DWORD
REG_MULTI_SZ
Multi-string
REG_EXPAND_SZ
Expandable string (either String or Multi-string)
To save a registry key
 1.
Select the predefined key that you want to save to a disk. 
 2.
On the Registry menu, click Save Key. 
 3.
In Save in, click the drive, folder, or network computer and folder where you want to save the hive. 
 4.
In File name, enter a name for the hive. 
 5.
In Save as type, click All files. 
 6.
Click Save. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

Registry Editor provides a number of commands that are designed primarily for the maintenance of your system. For example, Load Hive and Unload Hive allow a part of your system to be temporarily downloaded onto another computer for maintenance. Before a hive can be loaded or restored, it must be saved as a key, either to a floppy disk or to your hard disk. 
To restore a registry key
 1.
Select the predefined keys in which you want to restore the hive. 
 2.
On the Registry menu, click Restore. 
 3.
In Look in, select the drive, folder, or network computer and folder in which the hive is located. 
 4.
Select the correct file name for the hive. 
 5.
Click Open. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

A restored hive overwrites an existing registry key and becomes a permanent part of your configuration. For example, to perform maintenance on part of your system, you can use Save Key to save a hive to a disk. When you are ready, you can then use Restore on the Registry menu to restore the saved key to your system. 
To load a hive into the registry
 1.
Click in either the HKEY_USERS or HKEY_LOCAL_MACHINE window. 
 2.
On the Registry menu, click Load Hive. 
 3.
In Look in, click the drive, folder, or network computer and folder that contains the hive you want to load. 
 4.
Click Open. 
 5.
In Key Name, type the name that you want to assign to the hive, and then click OK. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

Load Hive and Unload Hive affect only the HKEY_USERS and HKEY_LOCAL_MACHINE keys and are active only when these predefined keys are selected. When you load a hive into the registry, the hive becomes a subkey of one of these keys. 
To unload a hive from the registry
 1.
Select a hive that you have previously loaded onto your system. 
 2.
On the Registry menu, click Unload Hive. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

Load Hive and Unload Hive affect only the HKEY_USERS and HKEY_LOCAL_MACHINE keys and are active only when these predefined keys are selected. When you load a hive into the registry, the hive becomes a subkey of one of these keys. 
To delete a registry key or a value entry
 1.
Click the key or value entry that you want to delete. 
 2.
On the Edit menu, click Delete. 
Notes

To cause Registry Editor to delete a key or value entry without asking you to confirm the deletion, on the Options menu, click Confirm on Delete. 

You can delete both keys and value entries from your registry. However, you cannot delete predefined keys (such as HKEY_CURRENT_USER) or change the name of a key. 
To confirm a deletion

On the Options menu, click Confirm on Delete. 
Note   If you are not using Read Only mode, you should use Confirm on Delete to protect your registry data from accidental deletions. When Confirm on Delete is selected, Registry Editor presents a dialog box asking for confirmation any time that you delete a registry key or a value entry. 
Edit Registry Information

Search for a key in the registry 

Use the String Editor 

Use the Binary Editor 

Use the DWORD Editor 

Use the Multi String Editor 
To search for a key in Registry Editor
 1.
On the View menu, click Find Key. 
 2.
In Find what, type the name of the key you want to find. 
 3.
You can narrow your search by doing the following: 

To find only occurrences of a word that are not part of a larger word, select the Match whole word only check box. 

To identify only those keys in the registry with the combination of uppercase and lowercase letters specified in Find what, select the Match case check box. 
 4.
In Direction, click the direction you want the search to proceed through the registry: 

To search the portion of the registry tree above the insertion point or selection, click Up. 

To search the portion of the registry tree below the insertion point or selection, click Down. 
 5.
Click Find Next to find each subsequent occurrence of the specified text until all occurrences have been found. 
To use the String Editor
 1.
Select a value entry of the type REG_SZ or REG_EXPAND_SZ. 
 2.
On the Edit menu, click String. 
 3.
In String, enter any changes, and then click OK. 
Note   A string is a sequence of characters. Many value entries in the registry are written in a string (REG_SZ) or in an expandable string (REG_EXPAND_SZ) format. An expandable string usually consists of text, but also contains a variable that will be replaced when it is called by an application. For example, in the value entry %systemroot%\System32\Bootok.exe, %systemroot% is the expandable portion of the variable, and will be replaced by the actual location of the directory that contains the Windows 2000 system files. If a value entry in Registry Editor has a REG_SZ or a REG_EXPAND_SZ prefix, you can edit the value entry using the String Editor. 
To use the Binary Editor
 1.
Click the value entry that you want to edit. 
 2.
On the Edit menu, click Binary. 
 3.
Under Data Format, click one of the following: 

To represent your data as a sequence of binary digits, click Binary. 

To represent your data as a sequence of hexadecimal digits, click Hex. 
 4.
In Data, enter any changes, and then click OK. 
Note   Many value entries in the registry are written as raw binary data. If a value entry is preceded by the prefix REG_BINARY, the value entry is written as binary data, and you must use the Binary Editor to edit this value entry. You can also use the Binary Editor to edit any other value entry, regardless of the format in which the entry is written. 
To use the DWORD Editor
 1.
Click a value entry of the type REG_DWORD. 
 2.
On the Edit menu, click DWORD. 
 3.
In Data, enter any changes. 
 4.
Under Radix, click one of the display options. 

To display the data as a binary (base-2) number, click Binary. 

To display the data as a decimal (base-10) number, click Decimal. 

To display the data as a hexadecimal (base-16) number, click Hex. 
Note   DWORD refers to data that is represented by a number that is four bytes long. If a value entry contains the prefix REG_DWORD, the entry is written in the DWORD format. 
To use the Multi String Editor
 1.
Click a value entry of the type REG_MULTI_SZ. 
 2.
On the Edit menu, click Multi String. 
 3.
In Data, enter any changes, and then click OK. 
Note   If a value entry contains the prefix REG_MULTI_SZ, the value entry is written as a multiple string. 
Maintain Registry Security

Assign permissions on a registry key 

Assign Special Access on a registry key 

Add users or groups to the Permissions list 

Grant full control of a registry key 

Audit activity on a registry key 

Add users or groups to the Audit list 

Take ownership of a registry key 

View registry data in the read only mode 

Select a font 
To assign permissions to a registry key
 1.
Click the key to which you want to assign permissions. 
 2.
On the Security menu, click Permissions. 
 3.
Assign an access level to the selected key as follows: 

To grant the user permission to read the key contents but not to save any changes made to the file, select the Allow check box for Read. 

To grant the user permission to open, edit, and take ownership of the selected key, select the Allow check box for Full Control. 

To grant the user special permission in the selected key, click Advanced. 
 4.
If you are assigning permissions to a subkey and you want the inheritable permissions assigned to the parent key to apply to the subkey also, select the Allow inheritable permissions from parent to propagate to this object check box. 
Note   If you own a registry key, you can specify the users and groups that can open that key. To determine who can open your registry keys, you need to assign permissions to them. You can add or remove users or groups from the list of those authorized to access your registry keys at any time. 
To assign Special Access to a registry key
 1.
Click the key to which you want to assign Special Access. 
 2.
On the Security menu, click Permissions. 
 3.
Click Advanced, and then double-click the user or group to whom you want to assign Special Access. 
 4.
Under Permissions, select the Allow or Deny check box for each permission you want to allow or deny. 
Notes

Assigning Special Access is useful for situations in which you need to assign permissions that are not defined by either Read or Full Control. 

If you are assigning permissions to a subkey and you want the inheritable permissions assigned to the parent key to apply to the subkey also, select the Allow inheritable permissions from parent to propagate to this object check box. 

If you are assigning permissions to a parent key and want any existing permissions of its subkeys replaced with the parent key's inheritable permissions, select the Reset permissions on all child objects and enable propagation of inheritable permissions check box. 
To add users or groups to the Permissions list
 1.
Click the key whose Permissions list you want to change. 
 2.
On the Security menu, click Permissions, and then click Add. 
 3.
In the Select Users, Computers, or Groups dialog box, in Look in, click the computer or domain of the users and groups you want to view. 
 4.
Click the name of the user or group, click Add, and then click OK. 
 5.
In the Permissions dialog box, under Permissions, assign a type of access to the selected user or group as follows: 

To grant the user permission to read the key contents but not to save any changes made to it, select the Allow check box for Read. 

To grant the user permission to open, edit, and take ownership of the selected key, select the Allow check box for Full Control. 
Notes

If the check boxes under Permissions are shaded, the key has inherited permissions from the parent key. 

To allow permissions assigned to a parent key to apply to its subkeys also, select the Allow inheritable permissions from parent to propagate to this object check box. This check box appears only if you are setting permissions on a subkey. 

In the Select Users, Computers, or Groups dialog box, if you type the name, rather than selecting it, click Check Names before clicking OK. 
To grant Full Control of a registry key
 1.
Click the key to which you want to grant Full Control. 
 2.
On the Security menu, click Permissions. 
 3.
Under Name, click the user to whom you want to grant Full Control of your registry key. 
 4.
Under Permissions, select the Allow check box for Full Control. 
Notes

You can permit another user to take ownership of a registry key only if you are the current owner of the key. 

To permit a user to to take ownership of a registry key, you must first grant the user Full Control of the key. 
To audit activity on a registry key
 1.
Click the key you want to audit. 
 2.
On the Security menu, click Permissions. 
 3.
Click Advanced, and then click the Auditing tab. 
 4.
Double-click the name of a group or user. 
 5.
Under Access, select or clear the Successful and Failed check boxes for the activities that you want to audit or to stop auditing: 
Select 
To audit
Query Value 
Any attempts to read a value entry from a registry key
Set Value 
Any attempts to set value entries in a registry key
Create Subkey 
Any attempts to create subkeys on a selected registry key
Enumerate Subkeys 
Any attempts to identify the subkeys of a registry key
Notify 
Any notification events from a key in the registry
Create Link 
Any attempts to create a symbolic link in a particular key
Delete 
Any attempts to delete a registry object
Write DAC 
Any attempts to write a discretionary access control list on the key
Write Owner 
Any attempts to change the owner of the selected key
Read Control 
Any attempts to open the discretionary access control list on a key
Notes

You must be logged on as an administrator or a member of the Administrators group to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

You must first add users and groups before specifying the events to audit. 
To add users or groups to the Audit list
 1.
Click the key you want to audit. 
 2.
On the Security menu, click Permissions. 
 3.
Click Advanced, click the Auditing tab, and then click Add. 
 4.
In Look in, click the computer or domain of the users and groups you want to view. 
 5.
Click the name of the user or group you want to add, and then click OK to open the Auditing Entry dialog box. 
Notes

You must be logged on as an administrator or a member of the Administrators group to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

You must first add a user or group before specifying which events to audit. 
To take ownership of a registry key
 1.
Click the key you want to take ownership of. 
 2.
On the Security menu, click Permissions. 
 3.
Click Advanced, and then click the Owner tab. 
 4.
Under Change owner to, click the new owner, and then click OK. 
Note   You can take ownership of a registry key if you are logged on as an administrator or if you have been specifically assigned the permission to take ownership of the registry key by the current owner. 
To view data in the Read Only mode

On the Options menu, click Read Only Mode. 
Note   Read Only Mode protects your registry data from potentially damaging, accidental changes. When you click Read Only Mode, Registry Editor does not save any changes that you make. 
To select a font
 1.
On the Options menu, click Font. 
 2.
In Font, click the font that you want. 
 3.
In Font style, click a font style. 
 4.
In Size, click a point size. 
 5.
In Script, click the appropriate script language for your computer. 
Notes

Sample displays your combination of selected font, font style, size, and script language. 

Your font selection affects all Registry Editor windows. 
Change the Appearance of Registry Editor

Switch between the tree and data views 

Split a Registry Editor window 
To switch between the tree and data views

On the View menu, click one of the following display options: 

To view both the tree and the data, click Tree and Data. 

To view only the registry tree, click Tree Only. 

To view only the value entries of a registry tree, click Data Only. 
Notes

Tree and Data is the default setting. 

You can use the Tree menu options to change the appearance of the registry tree. 
To split a Registry Editor window
 1.
On the View menu, click Split. 
 2.
Use the mouse or the arrow keys to move the vertical bar. 
 3.
Click to set the dividing bar at its current location. 
Note   To cancel Split, press ESC before clicking. 
Print Registry Information

Print a subtree of the registry 
To print a subtree
 1.
In the tree pane of a Registry Editor window, select a key. 
 2.
On the Registry menu, click Print Subtree. 
Note   When you print a key, Registry Editor prints the key, its descendent keys, and all of the value entries of all of its descendent keys. 
Registry Editor (Regedit.exe)

How to... 

Concepts 
How To...

Change keys and values 

Import and export registry keys 

Print the registry 
Change Keys and Values

Find a string, value, or key 

Add a registry key to Favorites 

Add a key 

Add a value 

Change a value 

Delete a key or value 

Rename a key or value 

Connect to a registry over the network 

Disconnect from a network registry 

Copy a registry key name 

Restore the registry 
To find a string, value, or key
 1.
On the Edit menu, click Find. 
 2.
In Find what, type the string, value, or key you want to find. 
 3.
Select the Keys, Values, Data, and Match whole string only check boxes to match the type of search you want, and then click Find Next. 
Notes

You can speed up the search by looking through only one type of information; for example, if you know that you are looking for a value entry, you can clear the Keys and Data check boxes, so that you will not search through those objects. 

To repeat the search, press F3. 
To add a registry key to Favorites
 1.
Select the registry key you want to add to Favorites. 
 2.
On the Favorites menu, click Add to Favorites. 
 3.
In the Add to Favorites dialog box, accept the default registry key name or type a new one. 

The registry key is added to the Favorites list. You can then return to this list by simply selecting it from the Favorites menu.
Notes

You can create a list of favorite/frequently visited registry keys. 

To remove a registry key from the Favorites list, on the Favorites menu, click Remove Favorite, and you can select one or more registry keys to remove from the Favorites list. 
To add a key
 1.
Double-click the registry list to which you want to add a new key, and then click the key above the location you want for the new key. 
 2.
On the Edit menu, point to New, and then click Key. 
 3.
Type a name for the new key, and then press ENTER. 
Note   If you make a mistake that results in your computer not starting properly, you can restore the registry. 
To add a value
 1.
Click the registry key or value entry where you want to add the new value. 
 2.
On the Edit menu, point to New, and then click the type of value you want to add: String Value, Binary Value, or DWORD Value. 
 3.
Type a name for the new value, then press ENTER. 
Notes

If you make a mistake that results in your computer not starting properly, you can restore the registry. 

When you add a value, the value name and data type are saved with a default value. 
To change a value
 1.
Select the value you want to change. 
 2.
On the Edit menu, click Modify. 
 3.
In Value data, type the new data for the value, and then click OK. 
Note   If you make a mistake that results in your computer not starting properly, you can restore the registry. 
To delete a key or value
 1.
Click the registry key or value entry you want to delete. 
 2.
On the Edit menu, click Delete. 
Notes

You can delete keys and values from your registry. However, you cannot delete a predefined key (such as HKEY_CURRENT_USER) or change the name of a predefined key. 

If you make a mistake that results in your computer not starting properly, you can restore the registry. 
To rename a key or value
 1.
Click the registry key or value entry you want to rename. 
 2.
On the Edit menu, click Rename. 
 3.
Type the new name, and then press ENTER. 
Notes

If you make a mistake that results in your computer not starting properly, you can restore the registry.

You cannot rename the root keys or the default value of a key. 
To connect to a registry over a network
 1.
On the Registry menu, click Connect Network Registry. 
 2.
In the Connect Network Registry dialog box, type the name of the computer to whose registry you want to connect. 
Notes

You must be logged on as an administrator or a member of the Administrators group on both your computer and on the remote computer before you can make any changes to the remote computer's registry. Network policy settings may also prevent you from completing this procedure. 

If you make a mistake that results in your computer not starting properly, you can restore the registry. 
To disconnect from a network registry
 1.
On the Registry menu, click Disconnect Network Registry. 
 2.
In the Disconnect Network Registry dialog box, click the the name of the computer from whose registry you want to disconnect. 
Note   If you make a mistake that results in your computer not starting properly, you can restore the registry. 
To copy a registry key name
 1.
In the registry tree (left pane), click a registry key. 
 2.
On the Edit menu, click Copy Key Name. 
 3.
Paste the name of the registry key into another program or document. 
Notes   If you make a mistake that results in your computer not starting properly, you can restore the registry.
To restore the registry
 1.
Click Options, and then click Print to print these instructions. They will not be available after you shut down your computer in step 2. 
 2.
Click Start, and then click Shut Down. 
 3.
Click Restart, and then click OK. 
 4.
When you see the message Please select the operating system to start, press F8. 
 5.
Use the arrow keys to highlight Last Known Good Configuration, and then press ENTER. 

NUM LOCK must be off before the arrow keys on the numeric keypad will function.
 6.
Use the arrow keys to highlight an operating system, and then press ENTER. 
Notes

Choosing Last Known Good Configuration provides a way to recover from problems such as a newly added driver that may be incorrect for your hardware. It does not solve problems caused by corrupted or missing drivers or files. 

When you choose Last Known Good Configuration, Windows 2000 restores information in registry key HKLM\System\CurrentControlSet only. Any changes you have made in other registry keys remain. 
Import or Export Registry Keys

Export all or part of the registry to a text file 

Import some or all of the registry 
To export all or part of the registry to a text file
 1.
On the Registry menu, click Export Registry File. 
 2.
In File name, enter a name for the registry file. 
 3.
Under Export range, do one of the following: 

To back up the entire registry, click All. 

To back up only a particular branch of the registry tree, click Selected branch and enter the name of the branch you want to export. 
 4.
Click Save. 
Note   You can use any text editor to work with the registry files you create by exporting. Registry files are saved with .reg extensions. 
To import some or all of the registry
 1.
On the Registry menu, click Import Registry File. 
 2.
Find the file you want to import, click the file to select it, then click Open. 
Print the Registry

Print all or part of the registry 
To print all or part of the registry
 1.
Click the computer or top-level key of the registry area you want to print. 
 2.
On the Registry menu, click Print. 
 3.
You can print the entire registry by clicking All or only part of the registry by clicking Selected Branch and typing the desired branch in the text box, and then click OK. 
Concepts

Registry editor overview 
Registry Editor Overview
Registry Editor is an advanced tool for changing settings in your system registry, which contains information about how your computer runs. Generally, it is best to allow Windows 2000 programs to modify the system registry, and to avoid making changes using the Registry Editor.
You should not edit your registry unless it is absolutely necessary. If there is an error in your registry, your computer may not function properly. If this happens, you can restore the registry to the same version you were using when you last successfully started your computer.
Notes

To start Registry Editor, click Start, click Run, and then type regedit. 

To safely use Registry Editor for such tasks as eliminating duplicate entries or deleting entries for programs that have been uninstalled or deleted, you should be prepared to both edit and restore the registry. 
Concepts
This section covers:

Windows 2000 registry overview 

Understanding the Windows 2000 registry 

Managing the Windows 2000 registry 
Windows 2000 Registry Overview
In Microsoft Windows 2000, system configuration information is stored centrally in a hierarchical database called the registry. The registry replaces many of the .ini, .sys, and .com configuration files used in Windows for MS-DOS and Microsoft LAN Manager.
For information about specific registry keys, see the Windows 2000 Resource Kit.
Understanding the Windows 2000 Registry
The registry contains configuration information, such as settings for utilities in Control Panel, that the Windows 2000 operating system continually references. This section covers:

Registry structure 

How Windows 2000 components use the registry 
Registry Structure
The registry is organized in a hierarchical structure of subtrees and their keys, subkeys, and value entries.
The contents of the registry for one computer may vary widely from that of another, depending on the devices, services, and programs installed on each computer. The following illustration shows an example of a registry, as viewed by a version of Registry Editor (Regedit.exe) provided with Windows 2000.
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Keys can have subkeys and subkeys can, in turn, have subkeys. While most information in the registry is stored on disk and is considered permanent, some information, stored in volatile keys, is overwritten each time the operating system starts. 
Registry Subtrees
Windows 2000 has two registry subtrees: HKEY_LOCAL_MACHINE and HKEY_USERS. However, to make the information in the registry easier to find, the Registry Editor utilities display five subtrees, which are listed and described in the following table.
Root key name 
Description 
HKEY_LOCAL_MACHINE
Contains information about the local computer system, including hardware and operating system data such as bus type, system memory, device drivers, and startup control data.
HKEY_CLASSES_ROOT
Contains information used by various OLE technologies and file-class association data (equivalent to the registry in Windows for MS-DOS). A particular key or value exists in HKEY_CLASSES_ROOT if a corresponding key or value exists in either HKEY_LOCAL_MACHINE\SOFTWARE\Classes or HKEY_CURRENT_USER\SOFTWARE\Classes. If a key or value exists in both places, the HKEY_CURRENT_USER version is the one that appears in HKEY_CLASSES_ROOT.
HKEY_CURRENT_USER
Contains the user profile for the user who is currently logged on interactively (as opposed to remotely), including environment variables, desktop settings, network connections, printers, and program preferences. This subtree is an alias of the HKEY_USERS subtree and points to HKEY_USERS\security ID of current user.
HKEY_USERS
Contains information about actively loaded user profiles and the default profile. This includes information that also appears in HKEY_CURRENT_USER. Users who are accessing a server remotely do not have profiles under this key on the server; their profiles are loaded into the registry of their own computers.
HKEY_CURRENT_CONFIG
Contains information about the hardware profile used by the local computer system at startup. This information is used to configure settings such as the device drivers to load and the display resolution to use. This subtree is part of the HKEY_LOCAL_MACHINE subtree and points to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Hardware Profiles\Current.
Each root key name begins with HKEY_ to indicate to software developers that this is a handle that a program can use. A handle is a value used to identify a resource so that a program can access it.
Notes

One version of Registry Editor, Regedit.exe, displays a sixth subtree, HKEY_DYN_DATA. This is a subtree of the Windows 95 and Windows 98 registries, but it is not used by Windows 2000. For more information about Registry Editor, see Using Regedt32.exe and Regedit.exe. 

The behavior of HKEY_CLASSES_ROOT is different from previous versions of Windows. In Windows 2000, a feature called per-user class registration provides a view of HKEY_CLASSES_ROOT that contains both user-specific class registrations and computer-specific class registration. With this feature, different users can have different sets of class registrations (including those for file associations, COM components, and MIME types). Previously, all users shared registrations, so that one user could alter registrations for other users. Per-user class registration isolates each user's registrations and allows the administrator to increase security on HKEY_LOCAL_MACHINE\Software\Classes. 
Registry Hives and Files
The term hive describes a body of keys, subkeys, and values that is rooted at the top of the registry hierarchy. A hive is backed by a single file and a .log file that are in the systemroot\System32\Config or the systemdrive\Documents and Settings\username folders. The string systemroot is a placeholder for the directory name that contains the Windows 2000 system files; the string systemdrive is a placeholder for the partition that contains the Windows 2000 system files. For example, if the Windows 2000 system files for a user named Annie are in a directory called Winnt in the C: partition, the hive files are stored in the C:\Winnt\System32\Config and C:\Documents and Settings\Annie folders. Hives may also be called registry files or registry log files.
By default, most hive files (DEFAULT, SAM, SECURITY, SOFTWARE, and SYSTEM) are stored in the systemroot\System32\Config folder. In Windows 2000, the location of user profile information for each user of a computer, including the Ntuser.dat and Ntuser.dat.log, may depend on whether the installation of the operating system was a fresh installation or whether it was installed as an upgrade from Windows 95, Windows 98, or Windows NT. In fresh installations and upgrades from Windows 95 and Windows 98, the Ntuser.dat and Ntuser.dat.log files are stored in the systemdrive\Documents and Settings\username folder. In installations that are upgrades from Windows NT, the Ntuser.dat and Ntuser.dat.log files are stored in the systemroot\Profiles\username folder.
Each hive in the Windows 2000 registry is associated with a set of standard files. The following table shows the standard hives and files for a computer running Windows 2000.
Registry hive 
File names 
HKEY_LOCAL_MACHINE\SAM
Sam and Sam.log
HKEY_LOCAL_MACHINE\SECURITY
Security and Security.log
HKEY_LOCAL_MACHINE\SOFTWARE
Software and Software.log
HKEY_LOCAL_MACHINE\SYSTEM
System and System.log
HKEY_CURRENT_CONFIG
System and System.log
HKEY_CURRENT_USER
Ntuser.dat and Ntuser.dat.log
HKEY_USERS\.DEFAULT
Default and Default.log
Value Entries in the Registry Keys
Each registry key or subkey can contain data called value entries. Some value entries store information that is specific to each user, while others store information that applies to all users of a computer. A value entry has three parts: the name of the value, the data type of the value, and the value itself. The three parts of value entries always appear in the following order.
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Data types describe the format of the data. Data types from 0 through 0x7FFFFFFF are reserved for definition by the system. Programs are encouraged to use these data types, but data types from 0x80000000 through 0xFFFFFFFF are also reserved for use by programs.
The following table lists the data types currently defined and used by the system.
Data type 
Description 
REG_BINARY
Raw binary data. Most hardware component information is stored as binary data and is displayed in Registry Editor in hexadecimal format. 
REG_DWORD
Data represented by a number that is 4 bytes long. Many parameters for device drivers and services are this type and are displayed in Registry Editor in binary, hexadecimal, or decimal format.
REG_EXPAND_SZ
A variable-length data string. This data type includes variables that are resolved when a program or service uses the data.
REG_MULTI_SZ
A multiple string. Values that contain lists or multiple values in a form that people can read are usually this type. Entries are separated by spaces, commas, or other marks.
REG_SZ
A fixed-length text string.
REG_FULL_RESOURCE_DESCRIPTOR
A series of nested arrays designed to store a resource list for a hardware component or driver.
Registry Size Limits
Registry data is stored in the paged pool, a portion of virtual memory that is written to a physical disk when not in use. A value called the registry size limit prevents programs from completely filling the paged pool with registry data.
You can view and set the size of the registry by using System in Control Panel. On the Advanced tab, click Performance Options, and then click Change. For more information about setting the registry size, see To change the maximum size of the computer's registry and To change the size of the virtual memory paging file.
By default, the registry size limit is 33 percent of the size of the paged pool. A registry size limit of up to 80 percent of the size of the paged pool is allowed. The minimum registry size is 16 megabytes (MB). If you attempt to set the registry size to anything smaller, the system resets this value to 16 MB.
You should change the registry size only if the computer is a domain controller for a large network or if you receive an error message warning you that the registry is too small. Note that setting a large value for the registry size limit does not cause the system to use that much space unless it is actually needed by the registry. In addition, a large value does not guarantee that the maximum space is actually available for use by the registry.
How Windows 2000 Components Use the Registry
The following illustration shows how Windows 2000 components and programs use the registry. The list that follows provides details.
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Setup. Both the Windows 2000 Setup program and other setup programs (for programs or hardware) add configuration data to the registry. For example, new information is added when you install a new SCSI adapter or change the settings for your display. Setup also reads information from the registry to determine if the prerequisite components are installed.
Recognizer. Each time you start a computer running Windows 2000, the recognizer places hardware configuration data in the registry. This data includes a list of hardware detected in your system. Hardware detection is done by the hardware recognizer (Ntdetect.com) and the Windows 2000 kernel (Ntoskrnl.exe) programs. 
Windows 2000 kernel. During system startup, the Windows 2000 kernel extracts information from the registry, such as which device drivers to load and their load order. The Ntoskrnl.exe program also passes information about itself (such as its version number) to the registry.
Device drivers. Device drivers send and receive load parameters and configuration data from the registry. This data is similar to what you might find on the DEVICE= lines in the Config.sys file in the MS-DOS operating system. A device driver must report the system resources that it uses, such as hardware interrupts and DMA channels, so that the system can add this information to the registry. Programs and device drivers can access this registry information to provide users with smart installation and configuration programs.
Administrative tools. You can use the options and administrative tools in Windows 2000 (such as those provided in the Administrative Tools folder in Control Panel) to modify configuration data indirectly.
Managing the Windows 2000 Registry
Most users of Windows 2000 never need to access the registry. However, managing the registry is an important part of a system administrator's job. This includes tasks such as viewing, editing, backing up, and restoring the registry. In addition, administrators need to consider security issues. For more information about security and the registry, see Maintain registry security. 
This section covers:

Using Regedt32.exe and Regedit.exe 

Backing up, restoring, and recovering the Windows 2000 registry 
Using Regedt32.exe and Regedit.exe
Windows 2000 provides two versions of Registry Editor: Regedt32.exe and Regedit.exe. Regedt32.exe is automatically installed in the systemroot\System32 folder. Regedit.exe is automatically installed in the systemroot folder.
You can modify the registry by using either of the Registry Editor utilities. However, if possible, you should use other utilities and tools provided with Windows 2000, such as those in Control Panel. When you modify the registry by using Registry Editor, Registry Editor does not check for syntax or other errors. In addition, one modification to the registry may cause a cascade of changes throughout the registry. The results of an incorrect edit made with Registry Editor are unpredictable and may impair or disable the Windows 2000 operating system. However, by using other tools and utilities, you can ensure that edits made to the registry are valid and manage any ensuing cascade of changes caused by an edit.
You can safely view the registry by using Regedt32.exe in read-only mode (on the Options menu, click Read Only Mode), so that you cannot inadvertently make changes.
Your ability to make changes to the registry by using Registry Editor depends on your access permissions. In general, you can make the same kinds of changes with Registry Editor as your permissions allow for other administrative tools. Users who belong to the Administrators group can view the registry of remote computers by using the Select Computer option on the Registry menu.
When you start Registry Editor, an associated icon appears on your taskbar. For information about starting Registry Editor, see Open Registry Editor.
For detailed instructions about using Registry Editor, see How to.
For recommendations about safely using the Windows 2000 registry and Registry Editor, see Best practices.
Backing Up, Restoring, and Recovering the Windows 2000 Registry
It is important that you have current, reliable backup copies of the registry. You should back up the registry as part of your regular backup routine and before you edit the registry. In Windows 2000, if you select the System State check box on the Backup tab in Backup, the registry is automatically backed up.
You can also use Backup to restore lost data to the registry. To do this, the system must be stable enough for you to open Backup. It is possible, however, for Windows 2000 to become so damaged by incorrect registry edits that it cannot start. You may be able to repair the operating system if you have created an Emergency Repair Disk (ERD). In the worst case, you must reinstall the operating system and device drivers and reconfigure the system before you can restore the data.
For more information about Backup, see Windows Backup overview.
For more information about backing up the registry, see To back up System State data.
For more information about creating an ERD, see To create an Emergency Repair Disk.
Troubleshooting
What problem are you having?
After editing the registry, one or more of the following occurs: files are missing, components are not behaving as expected, error messages or stop errors are displayed, or the operating system does not start.
Cause: A corrupt or damaged registry.
Solution: Before reinstalling Windows 2000 to fix the problem, try the following:

If you have kept a record of the changes that you have made to the registry, try undoing the most recent change. 

If you know which components have been affected, determine what the correct registry settings are for those components. For more information about specific registry settings, refer to the online documentation for that component or the Windows 2000 Resource Kit. 

Try using the last known good configuration for your computer. For more information, see To start Windows 2000 using the last known good configuration. 

If you have a backup copy of the registry (as part of your backup of System State data), and you can open Backup, try to restore your registry settings. For more information, see To restore the System State data. 

If you cannot start Windows 2000, try repairing the operating system with your Emergency Repair Disk (ERD). For more information, see To repair a system that will not start. 

If your operating system is damaged beyond repair (or if you must replace your hard drive), see the Windows 2000 Server Getting Started book that came with your Windows 2000 CD for instructions on reinstalling the operating system.
